Learning Outcomes

When you have completed this module, you will be able to:

1. Describe materials and apply them to solids, surfaces, faces.
2. Describe how materials can be used from the materials library or created and added to the materials library.

Materials

Materials in the current drawing can be applied to individual solids, surfaces, faces or to objects on a layer. See Figure 8-1. All materials in the current drawing appear as a swatch in the Materials or Materials Browser window.

Materials in the AutoCAD's Materials Library can also be used in current drawing. Users can create their own materials using the tools and the templates in the Materials or Materials Browser window. After a material is created, it can be applied to objects in the current drawing.

All materials have physical properties attached to them. The properties can be changed to achieve the desired effect on the model. The available property options depend on the selected material type.

Figure 8-1
Materials Applied to Objects
**System Variable:** VSMATERIALMODE
Controls the display of materials and textures in the current drawing.

**Command:** MATBROWSEROPEN
The MATBROWSEROPEN command opens the Materials Browser window. This command is only available in AutoCAD 2011 to 2014.

**Command:** MATERIALS
The MATERIALS command opens the Materials window
Applying Materials to Objects in the Model  
For AutoCAD 2011-2014 Users only

If you are an AutoCAD 2009-2010 User, skip to page 8-16.

**Step 1** Open the drawing AutoCAD 3D Advanced Workalong 07-1. Using the SAVEAS command, save the drawing with the name AutoCAD 3D Advanced Workalong 08-1.

**Step 2** Set the current workspace to 3D Modeling, the current view to Home and the current UCS to World. (Figure Step 2)

**Step 3** Open the Properties window. Without entering a command, using a window, select all objects in the drawing. Check the Material property in the 3D Visualization area. It should indicate that all materials are set to Global. (Figure Step 3)
Step 4  Enable the Render tab. Click the button to enable the display of materials and textures in the drawing. (Figure Step 4)

Step 5  Open the Materials Browser window by clicking the button. (Figure Step 5A and 5B)

Author's Comments:  Note how there is only one material currently loaded in the active drawing. It is the default material Global. It is part of all new drawings.

Author's Comments:  When they are not required, disable the display of materials and textures. This will maximize performance of the computer while you are working on the drawing. For the remainder of this workalong, leave the display enabled.
Step 6  Open the Materials Editor window by clicking the small arrow icon in the bottom right corner of the menu tab. (Figure Step 6A and 6B)

![Figure Step 6A](image1)

![Figure Step 6B](image2)

Step 7  Pull down the Color list and enable Color. (Figure Step 7)

**Author's Comments:** By disabling Color By Object, the color of the object, when rendered, is obtained from the material assigned to the object.
Step 8  Click Edit Color. In the Select Color dialogue box, move the scale bar up until Red, Green and Blue are set to 166. You can type it in 166,166,166 in color box, if you wish. (Figure Step 8)

Step 9  Change the color of layer Roof to 253.

Step 10  Click OK, and your drawing should appear as shown in the figure. (Figure Step 10)
**Step 11**  In the Material Browser window, right click the My Materials library and in the right-click menu, click Create Category.  (Figure Step 11)

**Step 12**  Enter the name Glazing for the new category.  (Figure Step 12)

![Figure Step 11](image1.png)

![Figure Step 12](image2.png)

**Step 13**  In the Materials Editor window, click the Create New Material icon.  In the pull down list, select Glazing.  Rename the material to Window Glass in the Name box.  (Figure Step 13A and 13B)

![Figure Step 13A](image3.png)

![Figure Step 13B](image4.png)

**Author’s Comments:** You just created a new material named Window Glass.
Step 14  The newly created material, Window Glass, will appear as a swatch in the Materials Browser. Right click it. In the right-click menu, click Add to, My Materials, Glazing. (Figure Step 14)

![Figure Step 14](image)

Step 15  Select the Glazing category. The Window Glass material should appear in the right panel. (Figure Step 15)

![Figure Step 15](image)
Step 16  Open the Properties window. Without entering a command, select one window solid object in the house. While the window object is selected, set the Material property to Window Glass. (Figure Step 16)

Author’s Comments:
You must be careful here to select the window object. You may have to zoom in.

Step 17  Using what you learned in Step 16, apply the Window Glass material to all exterior windows in the house. You will have to orbit the house so that you can apply the materials to all windows. There are small windows on the sides of the front door. (Figure Step 17)
**Step 18** Create the categories **Masonry** and **Wood** under **My Materials**. (Figure Step 18)

**Figure Step 18**

**Step 19** Select **Autodesk Library**. Set the view to **Text View**. (Figure Step 19)

**Figure Step 19**
Step 20  Scroll down the list of materials and find Common Brick in the Masonry - Brick category. Right click it. In the right-click menu, add it to My Material in the Masonry category. (Figure Step 20A and 20B)
Step 21  Using what you just learned in the last step, add the material Ash Door in the Wood-Panels category.  (Figure Step 21)

![Image of material selection in AutoCAD](image1.png)

Figure Step 21

Step 22  Select the Common Brick material to load it into the current drawing.  (Figure Step 22)

![Image of material selection in AutoCAD](image2.png)

Figure Step 22
**Step 23** Select the Common Brick material. In the Materials Editor window, edit the image and set the scale as shown in the figure. (Figure Step 23A and 23B)

**Author’s Comments:** The scaling is set here to adjust the size of the brick to display correctly on the model.

![Figure Step 23A](image)

![Figure Step 23B](image)
Step 24 Using what you learned, apply the material Common Brick to the exterior walls and the material Ash Door to front and rear doors of the house.

Step 25 Your drawing should appear as shown in the figure. (Figure Step 25)

Step 26 Using what you learned, load the masonry material Stacked - Gray Masonry into the current drawing and apply the material to the chimney. (Figure Step 26)
**Step 27** Your drawing should appear as shown in the figure.  (Figure Step 27)

**Step 28** Using what you learned earlier, render the model using the preset Medium.  (Figure Step 28)

**Step 29** Save the rendered image as a jpg with the name: AutoCAD 3D Advanced Workalong 08-1.

**Step 30** Save and close the drawing.
Applying Materials to Objects in the Model
For AutoCAD 2009-2010 Users only

If you are an AutoCAD 2011-2014 User, skip to page 8-30.

**Step 1** Open the drawing AutoCAD 3D Advanced Workalong 07-1. Using the SAVEAS command, save the drawing with the name AutoCAD 3D Advanced Workalong 08-1.

**Step 2** Set the current workspace to 3D Modeling, the current view to Home and the current UCS to World. (Figure Step 2)

**Step 3** Open the Properties window. Without entering a command, using a window, select all objects in the drawing. Check the Material property. It should indicate that all materials are set to Global. (Figure Step 3)
**Step 4**  Enable the Render tab. Click the icon in the Materials panel to enable the display of materials and textures in the drawing. (Figure Step 4)

![Figure Step 4](image)

**Step 5**  Click the small arrow icon on the right side of the Materials panel. This will open the Materials window. (Figure Step 5A and 5B)

![Figure Step 5A](image)

**Figure Step 5B**

**Author's Comments:** Note how there is only one material current loaded in the active drawing. It is the default material Global. It is part of all drawings.

**Author's Comments:** When they are not required, turn off the display of materials and textures. This will maximize performance of the computer while you are working on the drawing. For the remainder of this workalong, leave the display enabled.
Step 6  Disable the Color: By Object box. (Figure Step 6)

Author's Comments:  By disabling color By Object, the color of the object is obtained from the material assigned to the object when the model is rendered.

Step 7  Click the Diffuse color icon. In the Select Color dialogue box, enable the True Color tab. Move the scale bar up until Red, Green and Blue are set to 166. You can type it in the box, if you wish. (Figure Step 7)
Step 8  The house model should appear as shown in the figure.  (Figure Step 8)

![Figure Step 8](image)

**Step 9**  Change the color of layer **Roof** to 253.

**Step 10**  Click the **Create New Material**. In the **Create new Material** dialogue box, fill it in as shown in the figure. Click OK.  (Figure Step 10A and 10B)

![Figure Step 10A](image)

**Author's Comments**: You just created a new material named **Window Glass**.
Step 11  In the Available Materials in Drawing area of the Materials window, select the material you created in Step 10. The name Window Glass should appear in the select material box. Pull down the template menu and select Glass - Clear. (Figure Step 11)

Author's Comments: The Window Glass material that you just created will appear as clear glass when assigned to an object in the model.

Step 12  With the Window Glass material selected as the current material, click the Checkered Underlay On button. (Figure Step 12)

Author's Comments: Checkered Underlay allows a transparent material, like Window Glass, to appear in the Materials window.
Step 13  With the Window Glass material selected as the current material, click the Apply Material to Objects icon. Select one of the windows in the house. (Figure Step 13A, 13B and 13C)

Author’s Comments: You must be careful here to select the window object. You may have to zoom in.
Step 14  Using what you learned in Step 13, apply the Window Glass material to all exterior windows in the house. You will have to orbit the house so that you can apply the materials to all windows. There are small windows on the sides of the front door. (Figure Step 14)

![Figure Step 14](image-url)

Step 15  Enable the View tab. Click the Tool Palettes icon to open the Tool Palettes window. (Figure Step 15)

![Figure Step 15](image-url)
**Step 16** Enable the **Doors and Windows - Material Library** tab.  (Figure Step 16)

![Figure Step 16](image)

**Step 17** Find and select **Doors - Windows, Wood Doors, Ash**.  While it selected, right click it.  In the right-click menu, click **Add to Current Drawing**.  (Figure Step 17A and 17B)

![Figure Step 17A](image)

![Figure Step 17B](image)
**Step 18** Using what you learned early in this module, open the Materials window and note how the material Doors - Windows, Wood Doors, Ash, that was added in Step 4, is now part of the available materials in the current drawing. (Figure Step 18)

![Figure Step 18](image)

**Step 19** Move the cursor onto the bottom of the tabs and right click the mouse. In the right-click menu, select the Masonry - Bricks - Materials Library. (Figure Step 19)

![Figure Step 19](image)
Step 20  Using what you just learned, add the materials Masonary.Unit Masonary.Brick.Modular.Fire and Common from the library into the current drawing.  (Figure Step 20A and 20B)

Author’s Comments: You should now have five materials loaded in the drawing.

Step 21  Using what you learned in Step 13, apply the material Doors - Window, Wood Doors.Ash to the front and rear exterior doors. (Figure Step 21)
Step 22  Using what you already learned, apply the material Masonry Unit Masonry.Brick.Module.Common to the exterior walls of the house.  (Figure Step 22A and 22B)

Author's Comments: The exterior wall is one solid model. The material can be applied in one step.
**Step 23** In the Materials window, select **Masonry Unit Masonry.Brick.Module.Common** to make it the selected material. Set the Material Scaling & Tiling and Material Offset & Review as shown in the figure. (Figure Step 23)

**Author's Comments:** The scaling and material offset is set here to adjust the size of the brick to display correctly on the model.
**Step 24** Using what you already learned, apply the material `Masonry.Unit Masonry.Brick.Modular.Fire` to the chimney. Set the Material Scaling & Tiling to that material as shown in the figure. (Figure Step 24)

![Material Editor](image)

**Figure Step 24**

**Step 25** Your house model should match the figure. (Figure Step 25)

![House Model](image)

**Figure Step 25**
Step 26  Using what you learned earlier, render the model using the preset Medium.
(Figure Step 26)

Step 27  Save the rendered image as a jpeg with the name:
AutoCAD 3D Advanced Workalong 08-1.

Step 28  Save and close the drawing.

The Key Principles in Module 8

1  Materials can be applied to individual solids, surfaces, faces or to objects on a layer.
2  Users can create their own materials or add materials to the current drawing from the Material Library that is part of the AutoCAD software.
Lab Exercise 8-1

<table>
<thead>
<tr>
<th>Drawing Name</th>
<th>Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoCAD 3D Advanced Lab 08-1</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Step 1  Open the drawing AutoCAD 3D Advanced Lab 07-1. Using the SAVEAS command, save the drawing with the name AutoCAD 3D Advanced Lab 08-1.

Step 2  Set the current view to Home and the current UCS to World.

Step 3  Turn Materials and Textures on.

Step 4  In the Materials window, disable color By Objects and set the color to 140,140, 140.

Step 5  Change the color of layer Roof to 251.

Step 6  Create a material named Window Glass and apply it to all exterior windows.

Step 7  Using the materials library, load materials of your choice for the exterior walls, the chimney and exterior doors. Apply those materials to the objects in the house.

Step 8  If required, adjust the scale of the materials.

Step 9  Using medium preset, render the image. Save the rendered images as a jpeg with the name AutoCAD 3D Advanced Lab 08-1.
Author's Comments: The excerpts on the following pages were taken from AutoCAD's Help files. They are not part of the AutoCAD 3D Advanced course but you may want to read them for a deeper understanding of the topics in the module. You can find the same material and more by pressing F1 in AutoCAD and search the Helps files for the appropriate topics.

Create Materials

A material is defined by a number of properties. The available options depend on the material type selected.

You can create a new material in the Materials window. In the Materials Editor section of the Materials window you can select a type of material and a template to create your new material.

After you set these properties, you can modify your new materials even more by using maps, such as texture or procedural maps, Advanced Lighting Override, Material Scaling & Tiling, and Material Offset & Preview settings.

In the Material Editor panel, you can set the following properties:

- **Realistic and Realistic Metal types.** Materials based on physical qualities. You can select a material template from a list of predefined materials such as Ceramic Tile, Glazed, Fabric, or Glass, and so on.

- **Advanced and Advanced Metal types.** Materials with more options, including properties that you can use to create special effects; for example, simulated reflections. Advanced and Advanced Metal types do not offer material templates.

One material is always available in a new drawing, GLOBAL; by default, it uses the Realistic template. This material is applied to all objects by default until the material is changed on an object. You can use this material as a base for creating a new material.

Depending on the type of material you use, one or more of the following properties may be available for you to refine your material.

Color

The color of a material on an object is different in different areas of the object. For example, when you look at a red sphere, it does not appear to be uniformly red. The sides away from the light appear to be a darker red than the sides facing the light. The reflection highlight appears the lightest red. In fact, if the red sphere is very shiny, its highlight may appear to be white.

You can set three types of colors for a material that uses the Advanced or two colors for the Advanced Metal material type.

- **Diffuse.** The main color of the material.

- **Ambient.** The color that appears on faces lighted by ambient light alone. The ambient color may be the same as the diffuse color.

- **Specular.** The color of a highlight on a shiny material. The specular color may be the same as the diffuse color.

The Realistic and Realistic Metal templates use only Diffuse color.
Shininess

The reflective quality of the material defines the degree of shininess or roughness. To simulate a shiny surface, the material has a small highlight, and its specular color is lighter, perhaps even white. A rougher material has a larger highlight that is closer to the main color of the material.

Other Properties

The following properties can be used to create specific effects:

- **Opacity.** A completely opaque object does not allow the passage of light through its surface. An object with no opacity is transparent. (Not available for metal material types.)

- **Reflection.** The reflection slider controls how reflective the material is. When set to 100, the material is fully reflective and the surrounding environment is reflected in the surface of any object to which the material is applied. (Not available for metal material types.)

- **Refraction.** In translucent materials, light rays are bent as they pass through the material and thus distort objects that are seen through the material. For example, at 1.0, the object behind the transparent object is not distorted. At 1.5, the object is distorted greatly, as if it were seen through a glass marble. (Not available for metal material types.)

<table>
<thead>
<tr>
<th>Material</th>
<th>Index of Refraction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vacuum</td>
<td>1.0 (exactly)</td>
</tr>
<tr>
<td>Air</td>
<td>1.0003</td>
</tr>
<tr>
<td>Water</td>
<td>1.3333</td>
</tr>
<tr>
<td>Glass</td>
<td>1.5 to 1.7</td>
</tr>
<tr>
<td>Diamond</td>
<td>2.419</td>
</tr>
</tbody>
</table>

- **Translucency.** A translucent object transmits light, but also scatters some light within the object; for example, frosted glass. The translucency value is a percentage: at 0.0, the material is not translucent; at 100.0, the material is as translucent as possible. (Not available for metal material types.)

- **Self-illumination.** The object appears to be emitting its own light. For example, to simulate neon without using a light source, you could set a self-illumination value greater than zero. No light is cast on other objects.

- **Luminance.** Luminance causes a material to simulate being lit by a photometric light source. How much light is emitted is a selected value in photometric units. No light is cast on other objects.

- **Two Sided Material.** Two Sided Material sets the property of the material as two sided. Set this property if you want both sides of the material to be rendered in the scene.
Materials Tool Palettes

The Materials tool palettes gives you quick access to preset materials selections.

Materials Library

A library of over 400 materials and textures is included with the product. The materials are available on tool palettes after they are installed and are displayed on the palettes with a checkered underlay.

A typical installation installs less than 100 materials on the Materials tool palettes. An additional 300 or more materials are available by optionally installing the Materials library. The library can be accessed through the Configuration button on Add/Remove features in the installer. By default, all of the Materials tool palettes are installed in the Tool Palettes File Locations path specified on the Files tab of the Options dialog box. (See Texture Maps Search Path on the Files tab for the location of texture maps.)

Note The Materials library components are always installed to the default location. If you change the paths before you install the Materials library, the new materials are not displayed on the tool palettes and the texture maps are not referenced by the materials. Either copy the newly installed files to the location you want, or change the path back to the default.

Overview of Materials

You can add materials to objects in your drawings to provide a realistic effect.

A material’s settings create its physical properties. The Materials tool palette in the Tool Palettes window provides a large number of materials already created for you. You use these material tools to apply materials to objects in a scene. You can also create and modify materials using the Materials window. The Materials window offers many settings to modify properties of the material.

The use of mapping adds complexity and texture realism to the material. For example, you can replicate a paved road with asphalt by using a noise map and apply it to an object representing the road in the scene. Use the tile map to replicate a brick and mortar pattern.

Use the Advanced Lighting Override to add properties to the material that affect the rendered scene when lit by indirect illumination from global illumination and/or final gather.

After maps are applied to a material and modified to your preference, a map can be adjusted on the object using various tools that are available from the Materials panel on the ribbon.
Modify Materials

<table>
<thead>
<tr>
<th>Concept</th>
<th>Procedure</th>
<th>Quick Reference</th>
</tr>
</thead>
</table>

Modify the properties of an existing material after it has been applied.

After a material has been created and applied, you can modify it in the Materials window. If the material has been assigned to a tool palette, you can modify it in the Materials tool palette.

Materials Window

The material swatches that are available in the drawing are displayed at the top of the Materials window. When you select a material swatch, the properties for the material become active in the Material window sections.

The sections of the Materials window display different property settings.

- **Available Materials in Drawing.** Displays material swatch previews and tool buttons.
- **Nested Map Navigation.** Displays the active material and the materials in the mapping tree.
- **Material Editor.** Displays the material types, templates, and properties.
- **Maps.** Displays the map channels, map type selection, tool buttons, and provides access to procedural map controls.
- **Advanced Lighting Override.** (Available under the Realistic and Realistic Metal material type.) Sets parameters that affect the rendering of the material when it is lit by photometric lights.
- **Material Scaling & Tiling.** Specifies a map channel or synchronizes a scaling and tiling factor to be shared across all map levels. This section is used for 2D (Texture map, Checker, Gradient Ramp, Tiles) maps and map channels (diffuse, bump, opacity, reflection).
- **Material Offset & Preview.** Specifies the Offset & Preview properties of maps on materials.

As you modify the settings, they are saved with the material swatch. The changes are displayed in the material swatch preview. When you render the drawing again, the changes occur on any objects that have the changed material.

You can change the name of the material and the material preview shape. Right-click the preview swatch, and click Edit Name and Description. By holding down the first button below the swatch preview window, a set of fly out buttons display different geometry options for the material preview.

**Note** If the material that you changed is on a tool palette, then you need to update the palette with the reused material.
Apply Materials to Objects and Faces

Concept

You can apply a material to individual objects and faces or to objects on a layer.

To apply a material to an object or a face (a triangular or quadrilateral portion of a surface object), you can drag the material from a tool palette onto the object. The material is added to the drawing, and it is also displayed as a swatch in the Materials window.

When you create or modify a material in the Materials window, you can

- Drag the material swatch directly onto objects in your drawing.
- Drag the material swatch onto the active tool palette to create a material tool.
- Apply a material to objects by layer (MATERIALATTACH). The material is applied to all objects on the layer whose Material property is set to BYLAYER (the default).
- Assign a material to an object by clicking the Apply Materials to Object button in the Materials palette.
Learning Outcomes

When you have completed this module, you will be able to:

1. Describe point lights and explain how point lights are used in a drawing and their properties are adjusted to create the desired lighting effect.
2. Insert point lights in the drawing and adjust their properties.

Point Lights

A **point light** is a stationary artificial light that radiates light in all directions. It does not target any object or have a target location. Point lights are used for general lighting effects. The `POINTLIGHT` command is used to insert a point light in the drawing.

A **target light** is a point light that has additional target properties. A target light is inserted in the drawing using the `TARGETPOINT` command. The main difference between a target light and point light is that a target light can be pointed at an object. A target light can also be created from an existing point light by changing its target property from No to Yes.

In the standard lighting workflow, the point light can be set manually so its intensity diminishes with respect to distance either linearly, according to the inverse square of the distance, or not at all. By default, the attenuation is set to None.

**Command:** `POINTLIGHT`

The `POINTLIGHT` command is used to insert a point light in the drawing.

**Command:** `TARGETPOINT`

The `TARGETPOINT` command is used to insert a target point light in the drawing.
**Adding Point Lights to the Drawing**

**Step 1** Open the drawing AutoCAD 3D Advanced Workalong 09-1. Using the SAVEAS command, save the drawing with the name AutoCAD 3D Advanced Workalong 10-1.

**Step 2** Using ViewCube, set the view to Home. (Figure Step 2)

**Step 3** Set the current USC is set to World and the current workspace to 3D Modeling.

**Step 4** Open the Lights in Model window. (Figure Step 4)

**Author’s Comments:** The number following the light type in the figure may not be the same in your drawing.
Step 5  Open the Properties window. Without entering a command, select all four spotlights. While they are selected, set the On/Off Status property to Off. (Figure Step 5A and 5B)
Step 6  Turn layer Points Pointlights on.

Step 7  Using ViewCube, change the current view to Parallel and SE Isometric. Set the current visual style to 3D Wireframe. Your house model should appear as shown in the figure. (Figure Step 7)

Author's Comments:  I added the points to make it easier for you to insert the point lights in the house model.

Step 8  Enable the Render tab. Click the Create Light panel menu. In the pull-down menu, click Point to insert a point light. Insert 8 point lights by snapping to the points (node) in the model. This can be done in one command. (Figure Step 8A, 8B and 8C)
**Step 9** Using ViewCube, set the view to Home. Your house model should appear as shown in the figure. (Figure Step 9)

![Figure Step 9](image1)

**Step 10** Render the model using the High preset. (Figure Step 10)

![Figure Step 10](image2)
Step 11  Save the rendered image as a jpeg with the name AutoCAD 3D Advanced Workalong 10-1.

Step 12  Turn layer Points Pointlights off.

Step 13  Open the Properties window. Select two of the point lights that are outside the house, one at a time, and set the Intensity factor property as shown in the figures. (Figure Step 13A and 13B),

Figure Step 13A

Figure Step 13B
Step 14  Render the model using the High preset. Save the rendered image as a jpeg with the name AutoCAD 3D Advanced Workalong 10-2. (Figure Step 14)

Step 15  Using what you learned earlier, set the Intensity factor property of the 5 point lights that are inside the house to 5.0. (Figure Step 15)
Step 16  Render the model using the High preset. Save the rendered image as a jpeg with the name AutoCAD 3D Advanced Workalong 10-3. (Figure Step 16)

Step 17  Turn the 3 spotlights on that are located at ground level. (Figure Step 17)
Step 18  Render the model using the High preset. Save the rendered image as a jpeg with the name AutoCAD 3D Advanced Workalong 10-4. (Figure Step 18)

![Figure Step 18](image-url)

Step 19  Save and close the drawing.

The Key Principles in Module 10

1  A point light is a stationary artificial light that radiates light in all directions. It does not target any objects or have a target location. The POINTLIGHT command is used to insert a point light in the drawing.

2  A target light is a point light that has additional target properties. They are inserted in the drawing using the TARGETPOINT command. The main difference between a target light and point light is a target light can be pointed at an object.
**Lab Exercise 10-1**

<table>
<thead>
<tr>
<th>Drawing Name</th>
<th>Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoCAD 3D Advanced Lab 10-1</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Step 1**  Open the drawing AutoCAD 3D Advanced Lab 09-1. Using the SAVEAS command, save the drawing with the name AutoCAD 3D Advanced Lab 10-1.

**Step 2**  Using ViewCube, set the view to Home. Set the current UCS to World.

**Step 3**  Turn all 4 spotlights off.

**Step 4**  Delete the 8 pointlights that currently exist in the drawing.

**Step 5**  Create 4 pointlights inside the house at locations of your choice.

**Step 6**  Create 4 pointlights on the exterior of the house at locations of your choice.

**Step 7**  Set the intensity of the pointlights until you get the effect that desired.

**Step 8**  Ensure that all 8 spotlight are on.

**Step 9**  Using High preset, render the view. Save the rendered images as a jpeg with the name AutoCAD 3D Advanced Lab 10-1.

**Step 10**  Turn the 3 spotlights on.

**Step 11**  Using High preset, render the view. Save the rendered images as a jpeg with the name AutoCAD 3D Advanced Lab 10-2.
**Author's Comments:** The excerpts in the following pages were taken from AutoCAD's Help files. Although, they are not part of the course, you may want to read them for a deeper understanding of the topics in the module. You can find the same material and more by pressing F1 in AutoCAD and search for the appropriate topics.

### Use Point Lights

<table>
<thead>
<tr>
<th>Concept</th>
<th>Procedure</th>
<th>Quick Reference</th>
</tr>
</thead>
</table>

A point light radiates light in all directions from its location.

#### Point Lights

A point light radiates light in all directions from its location. A point light does not target an object. Use point lights for general lighting effects. You can create a point light by entering the `POINTLIGHT` command or by selecting a point light from the Lights panel on the ribbon.

You create a target point light with the `TARGETPOINT` command. The difference between the target point light and a point light is the additional target properties that are available. A target light can be pointed to an object. A target point light can also be created from a point light by changing the target property of the point light from No to Yes.

In the standard lighting workflow, you can set a point light manually so its intensity diminishes with respect to distance either linearly, according to the inverse square of the distance, or not at all. By default, the attenuation is set to None.
Adjust Light Placement

Concept Procedure Quick Reference

After a light has been placed in a scene the position and target can be modified.

The light, which is represented by a light glyph, can be repositioned after it is placed in the drawing. The light can be moved and rotated; the target can be modified. When the light glyph is selected, grips are displayed.

By selecting the light with a right-click, a shortcut menu is displayed that provides the following options for adjusting the placement of a light:

- **Move.** Activates the MOVE command. Used to change the position of the light.
- **Rotate.** Activates the ROTATE command. Used to change the orientation of lights. In addition to shortcut menu access, you can use ROTATE, 3DROTATE, and ROTATE3D commands.
- **Flip.** Rotates the target of the light in the opposite direction.

**Note** Rotating a targeted light is useful for aligning the area shadow region appropriately. Also, the orientation of the area shadow light is reset when the position or the target of the light is changed.

Location (Point Lights and Spotlights)

You can use the grip labeled Position to move a point light or a spotlight, or you can set the location in the Properties palette. The Position grip moves the light but does not change the target. To move both the light and its target, drag the light glyph itself.
Learning Outcomes:

When you have completed this module, you will be able to:

1. Describe sky background lighting and explain how to apply and adjust sky background and illumination.

Sky Background

The sun and sky are the primary sources of natural illumination in an AutoCAD drawing. As taught earlier in the eCourse, the rays of the sun are parallel and of a yellowish hue while the sky light (light cast from the atmosphere) comes from all directions and is bluish in color.

To enable the Sky Background, the view must be in a perspective and the system variable LIGHTINGUNITS must be set to 1 or 2.

The view can have a sky background or a sky background and illumination. Additional sky illumination adds extra light to the scene, simulating the effect of light scattered by the atmosphere throughout the scene. This additional light is only visible in rendered view.

Creating Views With Backgrounds

The VIEW command provides a mechanism for creating and managing named views. Once a view is named and saved, it can be restored at anytime it is required by the user. Background images can be assigned to a view so that it displays the raster file as a background in the view.

System Variable: LIGHTINGUNITS

Controls whether generic or photometric lights are used, and indicates the current lighting units.

When this system variable is set to 1 or 2, photometric lighting is enabled; otherwise standard (generic) lighting is used.

0  No lighting units are used and standard (generic) lighting is enabled.
1  American lighting units are used and photometric lighting is enabled.
2  International lighting units are used and photometric lighting is enabled.
Adding and Adjusting Skylight

**Step 1** Open the drawing AutoCAD 3D Advanced Workalong 10-1. Using the SAVEAS command, save the drawing with the name: AutoCAD 3D Advanced Workalong 13-1.

**Step 2** Set the current view to Home and the current UCS is World. (Figure Step 2)

**Step 3** Turn off all artificial lights. Ensure that the distance light and the sunlight are on. (Figure Step 3)
Step 4  Enter the LIGHTINGUNITS system variable, as shown below, and set it to 2. When you are asked if you want to disable distance lights, click Allow distance lights. (Figure Step 4)

Command: **LIGHTINGUNITS**
Enter new value for LIGHTINGUNITS <0>:  2
Command:

![Figure Step 4](image)

Step 5  Click the Grid icon in the status bar to enable the grid display. (Figure Step 5)

![Figure Step 5](image)

Author’s Comments:  If you enabled the grid display, it displays on the ground level or Z0. The displayed grid helps to see ground level when enabling the sky lighting.
**Step 6**  Using *Orbit*, rotate the model slightly up, by eye, to match the figure the best you can. (Figure Step 6)

**Author's Comments:**  As you rotate the model, you will see the horizon where the grid meets the sky.

**Step 7**  Pull down the *Lights* menu and disable the *Light glyph display*. (Figure Step 7)
**Step 8** Enable the View tab. Click the Named Views icon to open the View Manager dialogue box. (Figure Step 8)

**Step 9** In the View Manager dialogue box, click the New box to create a new view. (Figure Step 9)
Step 10  In the **New View** dialogue box, enter the view name **Module 13**. Leave all other settings as default. Click **OK** to close the dialogue box. (Figure step 10)

![Figure Step 10](image-url)

Step 11  In the **View Manager** dialogue box, click the view **Module 13**, to select it. While it is selected, click the **Set Current** box to make it the current view. (Figure Step 11)

![Figure Step 11](image-url)
Author's Comments: Creating and naming views makes it easy to display that view, when required.

Step 12   Enable the Render tab. Pull down the Sky menu and enable Sky Background. (Figure Step 12)

Figure Step 12

Step 13   With the render preset set to High, render the view. (Figure Step 13)

Figure Step 13

Step 14   Save the rendered image as a jpeg with the name: AutoCAD 3D Advanced Workalong 13-1.
**Step 15** Enable the **Render** tab. Click the sky pull down menu and enable **Sky Background and Illumination**. (Figure Step 15)

**Figure Step 15**

**Step 16** With the render preset set to **High**, render the view. (Figure Step 16)

**Figure Step 16**

**Step 17** Save the rendered image as a jpeg with the name: AutoCAD 3D Advanced Workalong 13-2.

**Author’s Comments:** With the **Sky Background and illumination** enabled, rendering the view will take longer to complete.
Step 18  Open the Sun Properties window. Set the
Intensity Factor in the Sky Properties to 0.25.
(Figure Step 18)

Step 19  With the render preset set to High, render the
view.  (Figure Step 19)

Step 20  Save the rendered image as a jpeg with the name:
AutoCAD 3D Advanced Workalong 13-3.
Step 21  Set the Intensity Factor in the Sky Properties to 0.07. (Figure Step 21)

Step 22  With the render preset set to High, render the view. (Figure Step 22)

Step 23  Save the rendered image as a jpeg with the name: AutoCAD 3D Advanced Workalong 13-4.
Step 24  Set the Intensity Factor in the Sky Properties to 1.0.  (Figure Step 24)

Step 25  Disable the sunlight.

Step 26  With the render preset set to High.  Render the view.  (Figure Step 26)

Step 27  Save the rendered image as a jpeg with the name: AutoCAD 3D Advanced Workalong 13-5.
Step 28  Turn on the three exterior pointlights and set their intensity to 10.0.

Step 29  With the render preset set to High, render the model. (Figure Step 29)

Step 30  Save the rendered image as a jpeg with the name: AutoCAD 3D Advanced Workalong 13-6.

Step 31  Set the sky to Sky Background. Enable the sunlight. (Figure Step 31)
Step 32  Open the Sun Properties window. In the Horizon area, set the Ground color property to 33,81,6. (Figure Step 32)

Step 33  With the render preset to High, render the view. Save the rendered image as a jpeg with the name: AutoCAD 3D Advanced Workalong 13-8. (Figure Step 33)

Step 34  Save and close the drawing.
The color and size of the light’s glyph appearance in the drawing can be adjusted in the Options dialogue box as shown below.

The Key Principles in Module 13

1. The sun and sky are the primary sources of natural illumination in an AutoCAD drawing.
2. To enable the Sky Background, the view must be in a perspective and the system variable LIGHTINGUNITS must be set to 1 or 2.
<table>
<thead>
<tr>
<th>Step 1</th>
<th>Open the drawing AutoCAD 3D Advanced Lab 10-1. Using the SAVEAS command, save the drawing with the name AutoCAD 3D Advanced Lab 13-1.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Set the current view to Home and the current UCS is World.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Turn off all artificial lights. Leave the distance light and the sunlight on.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Enter the LIGHTINGUNITS system variable, as shown below, and set it to 2. When you are asked if you want to disable distance lights, click Allow distance lights.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Pull down the Lights menu and disable the Light glyph display.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Click the Grid icon in the status bar to enable the grid display.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Using Orbit, rotate the model slightly up, by eye.</td>
</tr>
<tr>
<td>Step 8</td>
<td>In the New View dialogue box, enter the view name Module 13. Leave all other setting as default. Click OK to close the dialogue box.</td>
</tr>
<tr>
<td>Step 9</td>
<td>Enable the Sky Background.</td>
</tr>
<tr>
<td>Step 10</td>
<td>With the render preset set to High, render the view. Save the rendered image as a jpeg with the name: AutoCAD 3D Advanced Lab 13-1.</td>
</tr>
<tr>
<td>Step 11</td>
<td>Click the sky pull down menu and enable Sky Background and Illumination.</td>
</tr>
<tr>
<td>Step 12</td>
<td>With the render preset set to High, render the view. Save the rendered image as a jpeg with the name: AutoCAD 3D Advanced Lab 13-2.</td>
</tr>
<tr>
<td>Step 13</td>
<td>Open the Sun Properties window. Set the Intensity Factor in the Sky Properties to 0.30.</td>
</tr>
<tr>
<td>Step 14</td>
<td>With the render preset set to High, render the view. Save the rendered image as a jpeg with the name: AutoCAD 3D Advanced Lab 13-3.</td>
</tr>
<tr>
<td>Step 15</td>
<td>Open the Sun Properties window. Set the Intensity Factor in the Sky Properties to 0.08.</td>
</tr>
<tr>
<td>Step 16</td>
<td>With the render preset set to High, render the view. Save the rendered image as a jpeg with the name: AutoCAD 3D Advanced Lab 13-4.</td>
</tr>
<tr>
<td>Step 17</td>
<td>Set the Intensity Factor in the Sky Properties to 1.0. Disable the sunlight.</td>
</tr>
<tr>
<td>Step 18</td>
<td>With the render preset set to High, render the view. Save the rendered image as a jpeg with the name: AutoCAD 3D Advanced Lab 13-5.</td>
</tr>
<tr>
<td>Step 19</td>
<td>Turn the three exterior pointlights on and set their intensity to 12.0.</td>
</tr>
</tbody>
</table>
Step 20  With the render preset set to High, render the view. Save the rendered image as a jpeg with the name: AutoCAD 3D Advanced Lab 13-6.

Step 21  Set the sky to Sky Background. Enable the sunlight.

Step 22  Open the Sun Properties window. In the Horizon area, set the Ground color property to 33,81,6.

Step 23  With the render preset set to High, render the view. Save the rendered image as a jpeg with the name: AutoCAD 3D Advanced Lab 13-7.

Step 24  Save and close the drawing.
Author's Comments: The excerpts on the following pages were taken from AutoCAD's Help files. They are not part of the AutoCAD 3D Advanced course but you may want to read them for a deeper understanding of the topics in the module. You can find the same material and more by pressing F1 in AutoCAD and search the Helps files for the appropriate topics.

Sun and Sky Simulation

The sun is a light that simulates the effect of sunlight and can be used to show how the shadows cast by a structure affect the surrounding area.

Sun and sky are the primary sources of natural illumination in AutoCAD. Whereas the rays of the sun are parallel and of a yellowish hue, the light cast from the atmosphere comes from all directions and is distinctly bluish in color. When the LIGHTINGUNITS system variable is set to photometric, more sun properties are available.

When the workflow is photometric (the LIGHTINGUNITS system variable is set to 1 or 2) the sun properties have more properties available and are rendered using a more physically accurate sunlight model. The sun color is disabled for the photometric sun; the color is computed automatically based on the time, date, and location specified in the drawing. The color is determined based on the position in the sky. When the workflow is generic or standard lighting (the LIGHTINGUNITS system variable is set to 0), the additional sun and sky properties are unavailable.

The properties of the sun can be modified by using the SUNPROPERTIES command. The Sun Properties window is displayed. The details of the settings are located under SUNPROPERTIES in the Command Reference.

The rays of the sun are parallel and have the same intensity at any distance. Shadows can be on or off. To improve performance, turn off shadows when you don’t need them. All settings for the sun except geographic location are saved per viewport, not per drawing. Geographic location is saved per drawing.

The angle of the light from the sun is controlled by the geographic location you specify for your model and by the date and time of day. These are properties of the sun and can be changed in the Sun Properties window and the Geographic Location dialog box. The time zone used is based on the location, but you can adjust it independently (TIMEZONE system variable).
Sky Background

The option to choose the sky background is only available when the lighting unit is photometric (the LIGHTUNGUNITES system variable is set to 1 or 2). If you choose the sky background and change the lighting to standard (generic) lighting (the LIGHTUNGUNITES system variable is set to 0), the sky background is disabled.

The sun and sky background can be interactively adjusted in a view that can be activated in the Sun Properties window by clicking the first button in the title bar of the Sky Properties. This button activates the Adjust Sun & Sky Background dialog box. Here you can change properties and preview the changes to the background.

Show Me: Adjust Sky Properties

Sky Illumination

The view can have a sky background or a sky background and illumination. This option is in the Sky Properties Status drop-down list in the Sun Properties window. Additional sky illumination adds extra light to the scene, simulating the effect of light scattered by the atmosphere throughout the scene. This additional light is only visible in rendered output when final gather is enabled. This can be found in the Advanced Render Settings palette.

Note: The default final gather setting of Auto enables final gather in rendering when sky illumination is turned on.

View

The VIEW command provides a mechanism for creating and managing named views. The sun and sky background can be assigned to a new named view under Background. The sky background relies on the sun data in the named view.

You can adjust sun and sky background interactively in a view in the Adjust Sun & Sky Background dialog box. Click the first button in the title bar of the Sky Properties. This button activates the Adjust Sun & Sky Background dialog box. Here you can change properties and preview the changes to the background.